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* Public Release 
 
Spin  Date  Fixes and Enhancements 
 
428*  06-13-2011 Fixed a problem in the Pan functions which was making them run 

slower. 
 
 
427* 06-01-2011 Fixed a problem where raster images falling outside of viewport 

boundaries were being improperly plotted in PDF. 
 
   Fixed a problem where certain raster image files were not plotting 
   in .pdf plots 
 

Set the Details Plug-In parameters file to always be in the User 
Home directory which is always writable to the user, thus fixing a 
permissions problem in cases where the Standards directory is not 
writable to the user. 
 

  
426* 03-18-2011 Fixed a problem where some True Type text fonts were not 

justifying properly  when plotted from the Plot Preview menu. 
 
 
425  03-11-2011 Internal testing. 
 
 
424*  02-22-2011 Fixed a problem where Repeated Items which have Attributes 

associated with them were listing twice in the RI Select menu and 
not displaying properly in the menu and when placed. 
 
Fixed a problem where some True Type text fonts were not 
justifying properly when plotted to .pdf. 

 
Fixed a problem where the Viewport Layer Lock display on the 
Project Page Select menu was not displaying Lock By Sheet 
properly. 

 
 
423*  01-25-2011 Fixed a problem in the Edit menu where the Entity Filter Color 

parameter was displaying a menu range color incorrectly if the filter 
color falls in the old 256 shaded band colormap menu range. 
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Fixed a problem in the Dimension String special edit where 
changing a manual dimension to automatic was not working 
properly. 
 
Enhanced the Add, Delete, and Move Vertex functions in the 
Pattern Geometry Edit commands so that the selected Pattern 
boundary remains selected until an <Enter> or F10 entry is given 
for the Vertex. This allows you to add, delete, or move multiple 
vertices on the selected Pattern boundary without having to 
reselect the Pattern. 
 
Enhanced the Add, Delete, and Move Vertex functions in the Zone 
Geometry Edit commands so that the selected Zone boundary 
remains selected until an <Enter> or F10 entry is given for the 
Vertex. This allows you to add, delete, or move multiple vertices on 
the selected Zone boundary without having to reselect the Zone. 
 
Enhanced the Add, Delete, and Move Vertex functions in the  
Polyline Geometry Edit commands so that the selected Polyline 
remains selected until an <Enter> or F10 entry is given for the 
Vertex. This allows you to add, delete, or move multiple vertices on 
the selected Polyline without having to reselect it. 
 
Fixed a problem where during edits, the specified Edit Window is 
corrupted when mouse wheel zooms or pans are performed, 
causing unexpected results in the edit. 
 
Added a setting to the User Preferences menu under the Crosshair 
/ Mouse section which disables the middle mouse click. The setting 
may be turned On (disable the click) or Off (the default). This is 
designed for users who use the mouse scroll wheel for zoom and 
pan and inadvertantly click the middle mouse button causing an 
unintentional point input. 

 
 
422  01-12-2011 Internal Testing 
 
 
421  11-08-2010 Internal Testing 
 
 
420  11-05-2010 Internal Testing 
 
 
419  10-18-2010 Internal Testing 
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418* 10-07-2010 Fixed a problem where the user custom startup file ustart.tx was 

not being properly executed during ARRIS startup. 
 
Fixed a problem where text placed with true-type fonts was plotting 
(and also printing to PDF) offset from it's proper location. 
 
Fixed a problem where raster images placed in Sheets were 
rotating 90 degrees on each redisplay. 
 
A reported problem where creating a PDF using 2 point, fit to page 
did not properly size and fit the drawing to the paper has been 
verified as working properly in this spin. Note that the desired 
margins for the PDF page must be properly set in the Export To 
PDF menu. 

 
 
417*  10-01-2010 Corrected a problem where the Pattern icon is not being created 

properly when making a new Pattern Entity Style in the Pattern 
Create menu. 
 
Fixed a problem where some of the ARRIS Styles Catalog brick 
patterns give an error when placing them. 
 
Fixed a problem where when making a .pdf of a drawing, certain 
text placed at a 45 degree angle is flipped 180 degrees in the .pdf  
 
Fixed a problem where the double slash network designation on 
"Network Neighborhood" file paths was not being properly held. 
This was most noticeable the Database Drawing/Sheet Select 
menu. 
 
Increased the number of Revisions allowed in Sheets from 99 to 
999. 
 
Fixed a problem on the Slab/Path menu where the Remake Slab 
button left click was not executing the command properly. 
 
Restored the Attribute button to the Entity Filter section of the Edit 
menu. 
 
Altered the View menu so that the Winport button under the Zoom 
heading allows you to define a zoom window in one Winport and 
display it in another. The Zoom Extents and Display (Display All) in 
all Winports that was previously under this button has been moved 
to be the default right-click on the All Winport button under the 



ARRIS 9.4 Update Notes 

Page 4 of 13 

Special Display heading. The Redisplay All Winports (current 
zoom) remains the left click command under the Special Display - 
All Winport button. 
 
Added a check to automatically load "filexx.sm" and "userxx.ml" on 
startup where "xx" is the ARRIS version number. This allows 
version specific custom Sigmacs and Menus. 
 
Fixed a problem in the Project Page List Manager where the 
Project variables used in selection were not being properly reset 
when the program exits. 

 
 
416*  05-04-2010 Revised the Viewport Layout menu for graphics and menu help. 

 
Added a new function to the Viewport Layout menu which will 
replace existing Viewports on a Sheet with a Viewport from the 
same database if a Viewport file exists in that database. 
 
The Recent Documents box on the File pull-down menu has been 
moved to be grouped with the other "Open" functions. 
 
The Recent Documents function has been completely overhauled. 
This feature is now a part of the Project Page / Database 
Drawing/Sheet Select menu. It is still called from the File pull down 
menu and a right click on the File icon on the Desktop menu, which 
now open the Project Page / Database Drawing/Sheet Select menu 
in Recent Documents mode. ARRIS now saves the last 12 
documents opened and the documents are presented in the menu 
in the same Project Mode that was current when the document was 
last opened. This allows all of the functions on the "Open" menus to 
now also apply to Recent Documents, including Plot, PDF, eZ, etc. 
 
A "DR/SHT LIST FILE" button has been added to the Project Page 
/ Database Drawing/Sheet Select menu. This button will list 
Pages/Drawings/Sheets to a text file and then open it in the default 
text editor where it may be viewed, saved, or printed as needed. In 
Project Mode the list contains all Page names, descriptions, and 
drawing/sheet references for the selected Project grouped by 
Category. In File Mode the list contains all drawings and sheets 
with descriptions for the currently selected database in the menu. In 
Recent Documents mode the list contains the Project Number, 
Project Name, Page Name, Page Description, and full file path or 
the database, drawing/sheet name, drawing/sheet description and 
full file path for all documents currently on the Recent Documents 
list. 
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Enhanced the Layer Manager Load/Copy function so that the layer 
list for a database to load/copy from is now read from the master.dr. 
of that database. This greatly improves the speed with which the list 
is displayed to the menu. The list is still sorted by layer number by 
default, and may still be sorted by layer name by selecting the title 
bar above the list. 
 
Enhanced the Pattern Placement command by adding a prompt for 
the Pattern Origin point if the Pattern type is "Line" or "Repeated 
Item". The Pattern origin determines the exact location of a line or 
RI pattern fill within the Pattern boundary, and was previously 
automatically placed at the first point in the Pattern boundary. The 
new prompt occurs after "Fill" is selected to end boundary input and 
place the Pattern, and does not occur if the Pattern Type is "Solid 
Fill". 
 
Fixed a problem in the Pattern Geometry Edit function where the 
pattern origin was not being properly replaced in the same location 
during edits. 
 
Fixed a problem in the Edit menu where the Line / Wall Type filter 
was being automatically set to type 0 when Lines/Walls were 
selected as the entity filter. 
 
Removed a restriction in the Layer Manager where changing the 
layer number of a layer if the permission on the layer is read-only 
was not allowed. 
 
Fixed a problem on the Sheet Create menu where the file type icon 
was overwriting the beginning of the file name on the left side of the 
menu if the menu is stretched out on a wide screen but wide screen 
mode is off. 
 
Fixed a problem where PDF files were being created with an offset 
under certain conditions. 
 
The ARRIS Encyclopedia has been updated to reflect recent 
changes and additions. 

 
 
415*  01-26-2010 Fixed a problem in Pattern Edit where the work layer was not being  

properly restored if the edited Pattern is not on the current work 
layer. 
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Fixed a problem in Zone Edit where the work layer was not being 
properly restored if the edited Zone is not on the current work layer. 

 
Fixed a problem in Polyline Edit where the work layer was not being 
properly restored if the edited Polyline is not on the current work 
layer. 
 
Fixed a problem in placing a Pattern by selection of an existing 
Polyline where the Polyline arc segments were not being read 
properly. 
 
Fixed a problem in placing a Zone by selection of an existing 
Polyline where the Polyline arc segments were not being read 
properly. 
 
Fixed a problem where the closing segment of a Polyline was not 
being drawn properly in the Polyline Edit Freeze function. 
 
The Polyline Freeze function may now be called from the general 
Edit menu. The Entity Filter must be set to Polyline and the Search 
criteria must be set to Single. 
 
Consolidated the temporary directory ARRIS uses to the 
environment variable "TEMP". This is set automatically by default to 
the MS Windows temporary directory. The environment variable 
"GSWAP" is obsolete and no longer used. 
 
Enhanced the Layer Manager Load/Copy Layer function for faster 
display of the layer list. 
 
Layer Manager - In the Load/Copy Layer function when a drawing 
is selected the list of layers now pages to the first selected layer 
instead of displaying from the top of the list. This gives a better 
visual indication of the layers selected, particularly if the database 
selected to load/copy from has a large number of layers. 
 
Layer Manager - In the Load/Copy Layer function the layer list title 
bar now shows the total number of layers available for selection in 
addition to the number actually selected. 
 
Layer Manager - In the Load/Copy Layer function a Search Layer 
button has been added. When selected, ARRIS will prompt for the 
layer name to search on the Load/Copy Layer list. If found the layer 
will be selected and the display will page the list to display the 
searched layer name. 
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Expanded the maximum length of choices for input in ARRIS to 256 
characters (previously 64). 

 
 
414  01-08-2010 Internal Testing 

 
 

413*  11-25-2009 Improved the speed of layer display and sorting in the Layer 
Manager. 
 
In the Layer Manager, the Layer Sort function has been disabled 
while a Sheet is loaded. Layer Sort is not needed in Sheets since 
there are only 2 active layers which are displayed at the top of the 
Layer list. After a sort if the 2 active layers were not at the top of the 
list, the modes could not be manipulated. Layer Sort is unchanged 
while a Drawing or Viewport are currently loaded. 

 
    Fixed a problem in Notes where the Note and leaders were not 
    being placed properly in the Edit - Remake function. 
 

Notes feature - the Edit - Revise Text function has been enhanced. 
It works similar to before in that it puts the Note text into the default 
text editor for changing. When the text is saved and the text editor 
is closed, the revised Note is now updated to the Note entity in the 
database immediately (as well as to the Edit Note menu). This 
means that a "Remake Note" is no longer required to update it. The 
revised Note is replaced with it's previous parameters including  
type (keynote or text note), mask, and frame regardless of the 
current settings. Leader locations also remain unchanged so a 
"Remake Note" may be required to update them, particularly for 
right leaders. 
 
Notes Feature - A new "Move Leader Point" button has been added 
to the Edit Note menu which allows you to move a single leader 
point on the Note selected for edit. The leader point must be 
selected using the F11 key. The cursor will form a rubber-band 
aiding in the placement of the new point location. The Note will be 
updated immediately and ARRIS will prompt for another leader 
point to move. An <Enter> Key or F10 input at this prompt will 
restore the Edit Note menu. 
 
Notes Feature - Text edits of keynotes are now allowed. Even 
though the text is not displayed in the database, it is carried with 
the Note entity. 
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Notes Feature - The Edit Notes menu has been enhanced such 
that a right click selection on the "Revise Text" button or on the 
Note display will refresh the highlight of the Note selected for edit in 
the database. This is sometimes necessary particularly if the Text 
Editor is used or the screen is redisplayed. 
 
Fixed a bug in Notes where a revised note from the Edit Note menu 
was sometimes not replaced on the proper layer. 
 
Added Polylines as a searchable boundary type in the Query Area 
feature. 
 
Added Patterns as a searchable boundary type in the Query Area 
feature. The area of the pattern is reported as a whole, meaning 
sub-boundaries of the pattern are added or subtracted from the 
Pattern in the same way the Pattern is displayed before the Pattern 
area as a whole is reported/added/subtracted in the Query Area 
menu. 
 
Added Polylines as a searchable boundary type in the Query 
Perimeter feature. 
 
Added Patterns as a searchable boundary type in the Query 
Perimeter feature. The perimeter reported is the sum of the Pattern 
boundary and all sub-boundaries. 
 
Added Feet/Inches as a display unit to the Query Perimeter feature. 
It is the default unit when the Query Perimeter menu is first started. 
When Feet/Inches are displayed, total length is displayed to the 
32nd of an inch and the Decimal setting is disabled. 
 
In the Color Mix feature, adjusted the menu color numbers to reflect 
the current range of colors beyond the standard 256 colormap color 
range instead of the old 256 color shaded band colormap numbers. 

 
The Import and Export menus called from the File pull-down menu 
have been updated. 
 
When the DWG/DXF Translator menu is called from ARRIS, the 
translator application libraries are now automatically reloaded. If the 
translator is not installed, ARRIS now gives an error message. 
 
The System Standard User Toolbar has been updated to utilize 
newer improved functions and to replace a few very seldom used 
functions with some that are more commonly useful. 
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Fixed a problem where the "Create LP File" function in ARRIS 3D 
was looking for files in an old location and giving an error. 
 
The Zone Placement commands have been updated for better 
control of marker and Zone placement. The look and feel of Zone 
placement is now similar to Patterns and Polylines. 
 
The Zone Placement function has been enhanced to include 4 new 
placement options. In addition to placing a Zone by Points, 
Rectangle, and Chase, you can also place a Circular Zone 
boundary, or define a boundary by selecting an existing Pattern or 
2D Polyline in the database. 
 
The Zone Placement function has been enhanced to include a 
"Backspace Point" function which removes the last boundary 
segment entered while defining a Zone boundary, and then allows 
you to continue defining the Zone boundary from there. This 
function is executed by selecting the "BSP" button on the Zones 
Application Sub-menu, or by pressing the UNDO button while 
placing a Zone boundary. 
 

 
 
412  10-30-2009 Internal Testing. 
 
 
 
411*  10-23-2009 Fixed a problem where small bits of a Pattern were being displayed 
    outside of the Pattern boundary in certain cases. 
 

Fixed a problem in the Group Edit Move function where the Group 
Definition Menu was being called up incorrectly with the Match 
Entity Move function. 
 
Fixed a problem in ARRIS++ where the Pattern Geometry Edit 
menu was not being called properly. 

 
    Enhanced the Database Drawing/Sheet Select function to improve 

the speed with which the Database Drawing/Sheet list is gathered 
and displayed to the menu. 
 
The Database Drawing/Sheet Select function has been enhanced 
in Select By File mode so that the menu display is paged to show 
the currently loaded database and drawing/sheet when the menu 
first opens. This allows easier selection of drawings close to the 
current in large drawing lists with naming conventions. It also 
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makes selection of the currently loaded drawing for plotting, PDF, 
and eZ much easier. 
 
The Pattern Placement function has been enhanced to include a 
"Backspace Point" function which removes the last boundary 
segment entered while defining a Pattern boundary, and then 
allows you to continue defining the Pattern boundary from there. 
This function is executed by selecting the "BSP" button on the 
Patterns Application Sub-menu, or by pressing the UNDO button 
while placing a Pattern boundary. 
 
The 2D Polyline Placement commands have been updated for 
better control of marker and Polyline placement. The look and feel 
of Polyline placement is now similar to the Geometry Edit functions 
for Polylines, Patterns, and Zones. 
 
The 2D Polyline Placement has been enhanced to include 4 new 
placement options. In addition to placing a Polyline by Points and 
Rectangle, you can also place a triangular Polyline (3 points), a 
circular Polyline, a new Polyline offset from an existing Polyline, 
and chase a series of existing lines/arcs. 
 
The 2D Polyline Placement function has been enhanced to include 
a "Backspace Point" function which removes the last 2D Polyline 
segment entered while defining a 2D Polyline, and then allows you 
to continue defining the 2D Polyline from there. This function is 
executed by selecting the "BSP" button on the 2D Polylines 
Application Sub-menu, or by pressing the UNDO button while 
placing a 2D Polyline. 
 
The 2D Polyline Geometry Edits have been enhanced to include 
several new functions. The Polyline Geometry Edits now include 
Delete, Move, and Copy Polylines, Merge 2 Polylines, Divide a 
Polyline, Reverse a Polyline, Toggle Closure, Toggle Spline setting, 
Add, Delete, and Move a Polyline Vertex, change a Polyline 
segment to Linear, and change a Polyline segment to Arc. You can 
also now freeze a Polyline to lines/arcs. 
 
Fixed a problem where selecting the Title Bar on the Group 
Definition Menu was cancelling the edit rather than just dropping 
the menu to be able to select things behind it. 
 
A new Repeated Item Remake function has been added to the 
Repeated Item menu under the Utilities heading. This function 
remakes selected Repeated Items to the current Pen, Color, Scale, 
and Rotation parameters. 
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Fixed a problem in the Pattern Repair function where work angle 
was not properly accounted for. 

 
 
410*  9-11-2009 Added a Pattern Repair function for repair of corrupted crosshatch 

Patterns. 
 
Enhanced the Pattern placement commands further for better 
display of Pattern boundaries in the process of being placed. 

 
 
409    Internal Testing 
 
 
408    Internal Testing 
 
 
407  08-26-2009 Fixed a problem where ARRIS was redisplaying the screen several 
    times when you changed the size of the screen window. 

 
 
 
406  08-24-2009 The Pattern (Crosshatch) placement commands have been  

updated for better control of marker and boundary placement. The 
look and feel of Pattern placement is now similar to the Geometry 
Edit commands. This should solve lingering display list problems 
and make patterns more stable and bug free. 

 
 
 
405 08-03-2009 Fixed a problem in the layer manager where the layer work and 

layer rename functions were not stable after changing the name of 
a layer. 

 
Fixed a problem in selecting a color from a menu with ARRIS++ 
loaded. 
 
Fixed a problem where .pdf files from multiple drawings were not 
being created properly. 

 
 
 
404*  07-30-2009 The ARRIS Learning Guide has been updated for ARRIS 9.4 
 

Fixed a problem where the Ceiling Grid function in ARRIS Architect 



ARRIS 9.4 Update Notes 

Page 12 of 13 

did not display properly when placed. 
 
    Added an "Assign Textures" button to the OpenGL Windows 

toolbar. 
 
Fixed a problem in the Layer Manager Load / Copy Layers menus 
where database names that have a space in them and begin with a 
number are not listed properly. 
 
Enhanced the Group Edit Move function so that it loops allowing 
multiple moves without restarting the command. 
 
Fixed a problem in the Repeated Item Catalog Manager where the 
RI Library Short List feature was not working properly when the 
library sub-menu was in List mode. 
 
Fixed a problem with PDF output where text font strokes were not 
meeting properly causing gaps and extensions in the letters. 
 
Fixed a problem where the ARRIS Display Window was not sizing 
correctly with the Display Window Slidebars on and the Widescreen 
adjust / menu sizing on. 
 
The Plot Spool name that ARRIS uses to send data to the plotter 
has been changed to the drawing/sheet name of each individual 
plot instead of "ARRIS_PLOT" for all plots. 
 
The Plot Screen function now properly gets the plot colors (RGB) 
from the currently loaded colormap instead of the system colormap. 
 
Fixed a problem where circles in a drawing that contains a Raster 
Entity were displayed over the menus when panned off of the 
drawing window. 

 
 
403  07-20-2009 Internal Testing 
 
 
402*  06-9-2009 The ARRIS Encyclopedia has been updated for ARRIS 9.4. 
 

Fixed a bug in the Layer Manager where the Layer Default color  
was not being saved properly. 

 
Fixed a problem where infill was not being displayed properly in 
Repeated Items in the comm.ri and Details application. 
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Enhanced the Layer Styles Save function in the Layer Manager 
such that if the New Layer Style Name setting is <None> and one 
(and only 1) item is selected on the Layer Styles list, the Layer 
Manager will re-save the selected Layer Style. The Layer Manager 
will prompt to overwrite the previous Layer Style. 
 
The Add New Layer pop-up menu in the Layer Manager has been 
moved to the right on the screen so that it does not cover the Layer 
Numbers or Layer Names on the Layer Manager menu below. 
 
Enhanced the Patterns Geometry Edit menu to include a Remake 
Pattern function. This enables you to remake patterns that may 
have corrupt pattern or boundary lines. 
 
Fixed the Freeze function on the Edit menu to give a graceful error 
message for Polylines which cannot be frozen. 
 
Fixed a problem in plotting in "Saved" mode from the plot menu 
where the defaults file was not being set properly. 
 
Fixed a problem in plotting multiple drawings to a single PDF file in 
the Open menus where the combined PDF file was not being 
created properly. 
 
Enhanced the PDF Plot output file setting in the Export Project 
Pages to PDF menu called from the Project Page / Database 
Drawing/Sheet menu so that <Project> is offered as a default. This 
setting uses the project number or database name as the default 
output pdf file name (depending on Project Mode). A right click 
selection on the Output File Name box sets the output file name to 
the <Project> setting. 

 
 
401*  05-8-2009 ARRIS 9.4 Release 


